EPILOG LASER

Laser & CorelDRAW Seminar

April 2010

Epilog Laser
16371 Table Mountain Parkway
Golden, CO 80403

303-277-1188 - Phone
303-277-9669 – Fax

Tech Support Direct Line – 1-303-215-9171

www.epiloglaser.com
Outline

**Brief Introduction/Terminology:**
1. History of Epilog and lasers in the engraving industry
2. How lasers work
3. Types of lasers in the engraving industry
   a. CO2
   b. Nd:YAG
   c. Fiber Lasers
4. Beam delivery systems for lasers
   a. Flying optics
   b. Galvanometer (Galvo)

**Print Driver:**
1. Raster
2. Vector
3. Speed/Power/Frequency
4. Print Quality/Resolution
5. Dithering
6. Center-Center Engraving
7. Rubber Stamps
8. 3D Engraving
9. Color Mapping

**User Features at the laser:**
1. Moving carriage by hand
2. Center-center engraving
3. Adjusting Speed and Power on the fly
4. Using the red dot pointer in conjunction with the numerical readout
5. USB/Ethernet

**CorelDraw X4:**
1. Workspace
2. Text
3. Bitstream Font Navigator
4. Using Text to Create Interest
5. What the Font?
6. Shape Tool
7. Other Tool Box Tools – So Many Options!!!!!
8. Crop tool
9. Knife tool
10. Contour
11. Lens Tool
12. Trace Bitmap
   a. Raster to vector conversion
13. Straighten image
14. Create boundary
15. Snap to guidelines
16. Scanning artwork
17. Using fills to create shading, interest and contrast
18. Image Adjustment Lab

**Engraving Photos:**
1. Getting started
2. Different materials
3. Artwork
   a. Determining suitability
   b. Scanning photos
   c. Color or B/W
   d. Digital images
   e. Sizing
   f. Inverting
4. Image Adjustment lab
   a. Contrast
   b. Brightening
   c. Masking
   d. Cutouts
5. Resolution
6. Cropping and sizing
7. Resample
8. Dithering/Mode – Grayscale, 1-bit
9. Removing background
10. Cutout lab
11. Using clip art

**Engraving Murals with tiles:**
**ADA Signage:**

**Glass Engraving with the laser:**
1. Using the rotary attachment
2. Sandblasting and the laser
3. Color on glass
   a. Cermark/TherMark
   b. Color filling

**Stainless steel engraving with laser marking material (LMM):**
1. Cermark
2. TherMark
3. Color

**Photo Engraving Software:**
1. PhotoGrav
2. PhotoLaser Plus – EngraveLab (CadLink)
3. Corel

**Print Merge:**

**Training Resources:**

1. Epilog web site - [www.epiloglaser.com](http://www.epiloglaser.com)
   [www.epiloglaser.com/tech_library.htm](http://www.epiloglaser.com/tech_library.htm) - Read all of Epilog’s “How-To” articles.

2. Additional Training Resources:

3. The Awards and Recognition Association
   [www.ara.org](http://www.ara.org).

**PRINT DRIVER**

**Raster Engraving**

Raster engraving is used for text, clipart, scanned images and virtually all graphic artwork.

**Vector Cutting**

Vector cutting uses a thin line and the laser operates in a plotter style mode where the laser is turned on and remains on while it follows the profile of a line.

In this example, we cut out the shapes from four different kinds of wood and then put them together to make a festive Thanksgiving turkey!
Resolution

Resolution determines engraving quality when you are engraving an image in raster mode. Resolution is expressed in dots per inch (DPI) and is determined by the number of lines, or dots, that are engraved for every inch of movement. Each horizontal line is referred to as a raster line. The higher the resolution, the finer the detail that can be achieved. Depending on your machine, Epilog offers resolutions from 75 DPI to 1200 DPI. 300 DPI is normally a minimum for production work. The higher the resolution, the greater the engraving time will be.

The illustration below shows the concept of raster lines. Each pass of the laser produces a single raster line. 600 raster lines per inch is the same as 600 DPI.
The diagram below shows the difference in dot density between 300 DPI and 600 DPI. The closer spacing of the dots (smaller gaps) at 600 DPI resolution is responsible for the higher quality engraving.

Please Note: Changing resolution does not change the spot size. It only changes the dot spacing. For most applications, simply changing the resolution is the preferred method of improving image quality. For more demanding applications, changing resolution and the spot size (lens focus length) is necessary.

LENSES – HOW THEY AFFECT SPOT SIZE, FOCUS LENGTH, AND DEPTH OF FIELD

Different lenses are used to perform different functions with your laser system. A 2.0 inch lens is supplied as standard equipment on all Epilog systems. The 2.0 inch lens is a very good general purpose lens that will fit the needs of most engraving and cutting applications. There are three optional lenses available for the EXT line of lasers to provide maximum versatility for all of your engraving and cutting needs. The spot size of the laser beam can be changed by installing a different lens assembly. A small spot size (achieved with a 1.5 inch lens) is used for higher resolution engraving to achieve finer engraving detail. A larger spot size (2.5 inch lens) can be used for lower resolution engraving and is also used for vector cutting. The 4.0 inch lens is used for specialized engraving applications and is a popular choice for cutting thick acrylic.

The following diagrams show how the different lenses are incorporated into the EXT systems. These concepts also apply to the optional 1.5 and 4 inch lenses offered for the Mini/Helix systems.
This diagram shows the vertical positioning of the 2.5, 2.0 and 1.5 inch lenses (Legend EXT only). It illustrates why auto-focus and a single manual focus gauge work with all three lenses. Instead of changing the length of the manual focus gauge, or supplying a different gauge with each lens, we place the different lenses at their appropriate height relative to the work piece. This setup allows the auto focus to work automatically with all three lenses without user input.

Relative spot sizes generated by different focal length lenses. (Spots are enlarged for illustration purposes. Size and shape of spots is approximate.)
The depth of field distance increases as the focus length increases. Accurate focus is less important with longer length focus lenses, but more critical as the focus length gets shorter.
**Focus Length** | 1.5 inch | 2.0 inch | 2.5 inch | 4.0 Inch
---|---|---|---|---
**Spot Size** | .003” (high resolution) | .004” (standard resolution) | .006” (low resolution) | .010”
**Depth of Field** | small + / - .075” | medium + / - .100” | larger + / - .125” | large + / - .187”
**Best Application** | 600 to 1200 DPI - very fine detailed engraving. | 300 to 600 DPI - general engraving and cutting | 300 DPI or less – general engraving, acrylic cutting. | 300 DPI or less in deep cavities – acrylic cutting.

**Please note:** There is a little bit of overlap in the uses of the different lenses. The 2.0 inch lens is a very good general purpose lens and is well suited for most applications. The optional lenses are more suited to specific applications where the work being done is of a more specialized nature.

In addition to the three standard lenses pictured above, Epilog also offers a 4.0 inch lens. The 4.0 inch lens is a very specialized lens that is usually reserved for cutting thicker acrylic. Many users feel that the greater depth of field that the 4.0 inch lens provides enhances the look of the sides of the acrylic. The 4.0 inch lens is also used for engraving applications where the engraving is being done at the bottom of a deep cavity, like the bottom of a bowl or on the inside of a shadow box that has tall sides.

The 4.0 inch lens is gray and is mounted in the bottom slot of the standard lens assembly and comes with a dedicated focus lens.

AUTO FOCUS MUST BE DEACTIVATED WHEN USING THE 4.0 INCH LENS
RESOLUTION & SPOT SIZE – Practical Implications

Now that we’ve learned more than we need to know about resolution and lenses, let’s take a look at some of the practical implications.

1) Speed and Power settings - Speed and Power settings will vary with resolution. For example, as we saw above, there is greater overlap of each raster line at 600 DPI than there is at 300 DPI. The additional overlap at 600 DPI has the effect of lasering over more of each line twice. This means that on material like wood, you will notice a greater depth of engraving at 600 DPI than you will at 300 DPI (this assumes you use the same Speed and Power settings and do not change lenses). Since most users like to engrave deeply into wood, using 400, or 600 DPI is a better choice than 300 DPI.

2) The Speed and Power recommendations in Section 10 of our manual take this into account, and you will see recommendations listed for 300, 400 and 600 DPI. These recommendations are set for the standard 2.0 inch lens.

The higher the resolution, the more raster strokes are made by the laser system. In essence, 600 dpi has twice the raster as 300 dpi setting.

**Frequency** refers to the pulsing of the laser as it cuts in **Vector Mode**.

- **Low Frequency**
  
  ![Low Frequency Diagram]

- **High Frequency**
  
  ![High Frequency Diagram]
**Speed, Power and Frequency**

The **Speed** setting controls how fast the carriage moves. Different materials require different dwell times to produce the desired results. Material such as wood require longer dwell times than plastic, so you would set your speed for wood at a slower speed setting than you would use for running plastics, which can be run at 100% speed.

The **Power** setting controls how much power is being output by the laser. You can control the laser output for 1 percent of its rated power top 100 percent. Some materials such as acrylic need almost no power to mark while materials such as wood require a lot of power.

The **Frequency** setting controls how often the laser pulses when vector cutting as was described on the previous page.

Epilog provides tables in our manuals for speed, power and frequency setting for most common material types. It’s very easy to get used to creating correct settings for your material. The chart below shows an example of the settings table.

<table>
<thead>
<tr>
<th>Material</th>
<th>300 DPI RASTER ENGRAVING</th>
<th>400 DPI RASTER ENGRAVING</th>
<th>600 DPI RASTER ENGRAVING</th>
<th>VECTOR CUTTING</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wood Cherry – Alder - Walnut</td>
<td>60/100</td>
<td>80/100</td>
<td>100/100</td>
<td>⅛” (3 mm) – 30/60/500</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>¼” (6.4 mm) – 20/100/500</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>¾” (9.5 mm) – 10/100/500</td>
</tr>
<tr>
<td>Acrylic</td>
<td>100/50</td>
<td>100/40</td>
<td>100/30</td>
<td>⅛” (3 mm) – 20/100/5000</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>¼” (6.4 mm) – 12/100/5000</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>¾” (9.5 mm) – 6/100/5000</td>
</tr>
<tr>
<td>AlumaMark</td>
<td>100/30</td>
<td>100/25</td>
<td>100/20</td>
<td>N/A</td>
</tr>
</tbody>
</table>
Dithering

Photo-dithering is usually used to make photographs more compatible with laser engraving. Photo-dithering is so useful that there is a whole software program dedicated to it - it’s called PhotoGrav! PhotoGrav offers more features than Epilog’s one-touch dithering, but our dithering uses the same algorithms and is very useful for simple to medium-complexity photo engraving.

Dithering is just a way for the software to shuffle pixels around to create a random, less structured look for graphic images. Dithering can be used for both photos and clipart images. The different dithering algorithms just scramble the pixels a little bit differently. Dithering can make for much better looking engravings – especially if you’re working in wood.

The picture below shows the same clipart image engraved using different dithering patterns and different resolutions.

Applying one of the dithering patterns to clipart has the potential to create a lot of interesting effects that are not easily achievable any other way.
**Center-Center Engraving**

In regular printing mode (non Center-Center), you print using the upper left corner of your page as your 0,0 starting position to precisely place your artwork. When using Center-Center your reference becomes the center of your graphic. Center-Center is used in conjunction with the Set Home feature on your systems front control panel.

Center-Center lets you specify a random point as your prime reference point. This is very handy for odd shaped items or if you need to place your graphic very precisely in a tight space that’s not easily identified using the normal X-Y grid coordinates that are used with the upper-left corner as Home position.

No matter where your image is on your page, your reference point is the center of that graphic. When you use Center-Center your graphic will engrave at the exact center of where you have set your Home position.

Other options include Left-Center - Left-Center Engraving

Top-Center - Top-Center Engraving
Stamp mode allows you to engrave and cut out rubber stamps in a way that was designed specifically for rubber stamp manufacturers.
3D Engraving

3D engraving is one of the most beautiful ways of creating images with a laser, but it’s also one of the most difficult. It’s difficult because creating the artwork requires an inordinate amount of time and talent. This one graphic (below) took an expert graphic artist over a week – full time – to create! But produced beautiful results. Remember - 3D engraving requires two or three passes at slow speed to get the depth required for a great 3D look.

You can also purchase 3D artwork from the Gantry Company – www.gantryco.com. They have a wide selection of readymade 3D artwork and will also create custom-made artwork.

There are some simple approaches to using 3D to enhance your images. If you go to our web site, you will find a tutorial on how to create simple 3D artwork that can be used to really make an award pop!

Go to www.epiloglaser.com/tech_library.htm to access the tutorial “Using the Contour Tool to Create 3D Engraveable Artwork”. You will find this tutorial is under the “Using CorelDraw Tools” heading. Below are images that were converted using the process from the tutorial.
Cleaning

One additional issue with 3D artwork is cleaning the wood pitch after engraving. Because you’re engraving so deeply into the wood, you’re generating a lot of pitch. One of the better cleaning agents we’ve used is a citrus hand gel. Just squirt some gel onto the engraved area and let it sit for a minute or two so the citrus can start breaking down the pitch. Then, scrub the engraved area with a soft brush to get a deep clean. Wash off the gel quickly with water and you’ve got a beautiful engraved piece.

Keep in mind that cleaning wood with water can cause the wood to warp if it is too thin. Usually this is not an issue because most 3D engraving is engraved into thicker wood plaques (3/4 inch), but if you’re using ¼ inch wood, you’ll probably get some warpage.
Color Mapping

Color mapping is usually used in vector mode when you want to score some parts of an image and cut through other parts. Architectural model making uses Color Mapping extensively.

Color Mapping can also be used for certain graphics that include thin lines that you don’t want to remove, but that you also don’t want to engrave. You can assign lines colors and turn Raster or Vector modes off for those lines.
CorelDraw X4

Workspace

- Title Bar
- Menu Bar
- Tool Bar
- Property Bar
- Tool Box
- Horizontal Ruler
- Dockers
- Status Bar

Corel Defaults

Change the default opening page.
To change the way Corel opens, go to Tools | Workspace | General. Click on the On CorelDRAW start-up pull down menu and you will see your options. I like to start a New Document.

**How to make permanent changes for opening page defaults**

Open a new Corel page and set all of the parameters that you want to use as defaults every time you open a new page.

In Corel X4 one default changes that almost everyone needs to make is the Outline Pen width. In X4 Corel made the default value 0.007 inches. Most people want to use 0.001 or 0.003 (hairline) as the default.

Once all of your parameters have been set, go to Tools | Save Settings as Default
**Hints**

Using the Corel Hints docker is probably one of the most useful help tools in existence.

To bring up the Hints docker, go to the Menu Bar | Window | Docker and click on Hints. The docker will show up on the right side of your screen with any other dockers you have selected.

The Hints docker provides instructions on how to use the tools in your Tool Box.

**Single letter commands**

You’re probably familiar with the Hot Keys that can be used to navigate easily around your workspace using your keyboard. Most hot keys are a combination of two keys such as Ctrl + C = Copy, Ctrl + V = Paste, etc.

Corel also has some hot keys that are single key commands. All single key commands are found in the Arrange menu under Align and Distribute.

With multiple objects selected you can use these single key commands to align objects.
Click on your text to display this toolbar.

Select your text and go to Arrange | Break text apart to separate the text from the path.
**Bitstream Font Navigator**

Use Bitstream Font Navigator to add fonts to your computer. Corel only loads a few fonts when you install the program onto your computer, but there are more than 1000 fonts on the DVD disk.

Bitstream is a program that is included with your CorelDraw disk. Go to Start | CorelDraw Graphics | Bitstream Font Navigator.

Open Bitstream Font Navigator and insert your CorelDraw DVD. To find your fonts on the X4 DVD, follow the path below. Unfortunately, Corel X4 separates the fonts alphabetically so loading all of them is a bit of a chore, but probably worth it if you want a lot of fonts at your disposal. Earlier versions of Corel made loading a lot of fonts easier, so if you have these earlier versions you can follow this general procedure to load those fonts. I believe Corel X3 placed the fonts on disk number 3.
Using Text to Create Interest

One of Corel’s great strengths is its ability to easily modify text to create interest in your artwork.

Which one looks better?
If you want you can break text apart down to individual letters while keeping text formatting.
Flip between Artistic Text and Paragraph Text by right clicking on the text you want to convert.
What the Font?

The feature requires your computer to be hooked up to an Internet connection.

Use What the Font? To determine what font is used in a scanned image. In this example, we’ve scanned the Harley logo and brought it into Corel. With the logo selected, click on Text | What the Font? You will be directed to the What the Font? Website.

Confirm the Glyph and the Character match and then click on Search.
You will be given several selections and you can pick the one that’s the closest match.

Use a high quality image when scanning to improve your chances of obtaining a perfect match!

Other Font web sites:

www.simplythebest.net

www.myfonts.com

www.dafont.com
**Shape Tool**

The Shape Tool has so many uses that it’s hard to show them all. Experiment with it to discover all of the different things it can do.

I’ve used it below to select the upper nodes for cropping.

Other Tool Box Tools – So Many Options!!!!!
Crop tool

The crop tool works on clipart as well as bitmaps. Select the area to crop and double click in the selected area.

Before cropping.

After cropping.
**Knife tool**

Sometimes you want to cut objects into custom shapes. This can be surprisingly easy to do. Start with any Corel object. We have a rectangle that we want to cut the corner from.

To access the knife tool, click on the triangle of the Crop tool and click on the Knife tool.

When you’re moving the knife it will be at a diagonal.

When the knife gets to the edge of an object it will snap to vertical.
Click on the start and draw a line across the object and then click off.

You can then separate the two pieces.

You can even draw a freehand line.
Contour

We’re going to show you how to use just one of the features available in the Contour tool.

There are a number of different applications where the Contour tool is very useful. One of these applications is for inlaying. When you inlay acrylic or wood, you can accommodate for the thickness of the laser beam, allowing you to create a very tight fit between mating parts by making one of the parts a little bigger or a little smaller than the piece it mates to. The Contour tool is especially helpful for complex shapes like the free-form logo in the sign below.

For the sign above, we used the artwork to the right of the sign to vector cut the red and black acrylic pieces that we then mated together.

This drawing shows a close up of one of the pieces. Notice that there is a red and a black outline. For this project, we always made the red outline a little bigger than the black outline. This created a very tight fit between mating pieces. The other image shows the separated red and black outlines that we used to vector cut the different pieces of acrylic.
To contour an object all you have to do is select your object, then decide if you want to contour to the inside or the outside. Determine the number of steps you want and the distance between steps. For acrylic cutting, a step of 0.01 inches is ideal.

When you have your attributes set, click Apply and your object will have a contour.

When you create a contour the process creates a group that you need to ungroup to access the separate pieces.

Make sure you select the contour object, or marquee select both the original object and the contour object then go to Arrange | Break Contour Group Apart. (If you only select the original object instead of the contour object the Break Contour Group Apart selection does not show up in the drop down menu).
Sometimes you want a simple outline that matches the outline of your artwork.

**Lens Tool**

The Lens tool can add interesting effects to some artwork. There are several different options with the Lens tool, but one of the more popular options is to invert a portion an object. The Lens tool is a docker and is found under the Effects menu.

In our example below we start off with white lettering inside a black box. We also have an ellipse which will be used as the lens.

Select the ellipse, then go to the Lens docker and pull down the menu and select the Invert option.
Click on Apply (make sure the little Lock icon is unlocked) and your ellipse will be inverted.

Now all you have to do is move the inverted ellipse wherever you want it to go and you have a great new look!

This tool is really easy to use because when you use it to invert any object it becomes your lens. Move it anywhere you want and it will invert whatever object you place it on. Just make sure that the lens is on the top layer (front of page).
**Trace Bitmap**

![Image of Trace Bitmap](image1)

**Straighten Image**

![Image of Straighten Image](image2)
**PowerClip**

Use PowerClip to contain one object inside of another. For our example, we want to place the photo inside of the ellipse.

First, select the object you want to place inside of the container.

Go to Effects | PowerClip | Place Inside Container

Click on the container – in our example, the red ellipse to obtain this effect.
If you need to move the object or edit it in any way, right click on the image for the following fly out:

Corel defaults this feature so the object being contained is auto-centered in the container. We have found that for most users this doesn’t work, but figuring out how to change the default is hard to do.

To turn off Auto-Center, go to Tools, Options | Edit and then click off of the Auto – Center new PowerClip contents.
Create Boundary

Snap to Guidelines

Image adjustment lab
Using Fills to Create Interest, Shading and Contrast
**Tips for Engraving Photographs**

There is a lot of interest in laser engraving photographs, but many users get discouraged when they can’t produce the same quality images that they see on display at trade shows. The following information will provide some strategies for experimenting with photos so that you can become comfortable lasering photos for your clients. Keep in mind that there is no one “correct” method of engraving photos. A lot of it is personal preference learned through experimentation.

Give these strategies a try. Make extensive notes and keep samples of how you prepared the photo and how you engraved it. These notes and samples will be invaluable to you in the future!

- **Getting Started** - The first thing you should do if you are new to photo engraving is set aside some quiet time to practice and get familiar with the process. There are probably some concepts here that are new to you, so it will be beneficial to try some of these ideas without distraction.

- **Different Materials** - A single photo is going to engrave differently from one material to the next. Many users like to use black marble for their photos. Black anodized aluminum, black plastic, clear acrylic, and wood are also popular materials, but they all react a little differently and you will need to compensate for the material.

- **Artwork** – Not all photos are going to engrave well. Photos that laser best are photos that contain a wide range of light to dark and everything in-between. Photos with large areas of a single color typically do not engrave well – especially when working with wood.

- **Software** – Virtually any graphics software has the ability to modify a scanned or digital photo for engraving. This paper addresses only CorelDraw and Corel PhotoPaint products, but the principals and tools apply to other packages such as Photoshop, etc.
  - There are two third party software packages available that are designed specifically for laser engraving – PhotoGrav, and a new product from CadLink’s EngraveLab called PhotoLaser. These software packages cost $400 to $500 and have some nice features that may make your photo manipulation easier than using Corel alone.

- **Engraving Resolution** – The process described below works quite well at lower resolutions of 200, 300 or 400 DPI. Many of the samples we produce are engraved at 200 or 300 DPI.

**The Process**

- **Determining the suitability of a photo for engraving** – As mentioned earlier, there are several considerations that need to be taken into account when determining whether a photo is suitable for engraving:
  - Ideally a photo will show many gradations of color from light to dark.
  - The photo will show good definition of detail.
  - The photo should have good contrast and focus.
The most suitable photos have a number of different elements to look at. In the photo below the hands break up the face and hair and the face itself is nicely shaded with features that are very distinct.

This photo is excellent for lasering because most of the photo is a gradient pattern of light to dark. There is not much in the way of big blocks of color and there is a lot of detail to make the photo really pop when lasered.

In contrast to the photo above, the next photo is not nearly as suitable for engraving.

This photo will only engrave well if the black background is taken out. Leaving the background intact will detract from the engraving by producing a large area that contains nothing to look at.

With that said, this photo can actually be saved with a little processing that we will show later on, but in general, avoid photos with large blocks of uninterrupted color.

Acquiring a Photo – Either scan an actual photograph, or download a photo from a digital camera.
- Scanning Resolution – Scan your photos at the resolution you plan using for engraving. If you’re only going to engrave at 200 DPI there is no reason to scan at a higher resolution.
- Color or B/W – Scan your photos in color mode. There are subtle advantages to using color that will be explored later.
- Digital images - Make sure you get the highest resolution digital image you can. Low resolution photos from the internet are almost never suitable for engraving. If you look hard you can occasionally find high resolution graphics on the internet, but the vast majority of images are low res and too small in size to be useful.
- Size - Get the largest size image available. Simply stretching a photo in Corel is going to reduce the resolution of the image and if the photo is stretched too far, the photo will become too pixilated to engrave. We will show how to properly stretch an image a photo later on.

**Processing the Photo** – CorelDraw has some very good tools that will help you easily prepare your photograph for laser engraving. These tools are also found in Corel Photo-Paint along with some more sophisticated tools that will make your photo even better. We’re going to start in CorelDraw and then move back and forth between it and Photo-Paint.

This part of the procedure describes processing a photo for wood engraving. If you follow these instructions and use the specific values as listed in this procedure you will be able to create the best photos on wood you have ever produced!

- Sizing – We’ve imported the image below into Corel. As you can see it’s too large for the plaque we’re engraving so we have to shrink it. In Corel you would normally grab one of the handles to shrink or enlarge an object until it looked good. With a photo we need to take more care.
Before sizing the photo, make a duplicate of it first and move it to the side. Use the duplicate image to experiment with sizing. Once you’ve determined the right size, measure it. We’ll need the measurements the photo needs to be in a minute.

Now, select the original image. Click on Edit Bitmap. This will open the bitmap in Photo-Paint.

In Photo-Paint, click on Image and Resample
Use the dimensions that you determined earlier in CorelDraw and type those dimensions into the Image Size boxes for Width and Height. Normally you only need to type in one of the values. If you've got the Maintain Aspect Ratio checked, you'll maintain the aspect ratio of the original photo. We're going to set a size of 4 inches in width.

At this point, we're also going to change the resolution of the photo. As you can see in the image above, we're increasing the resolution from 200 to 300 DPI. This will give a little better quality image. The resolution here should be divisible into the engraving resolution you're going to use. We're going to use 600 DPI for our engraving resolution when we print so 300 DPI goes into 600 2 times. You can go as high as 600 DPI in this setting, but the higher you go, the larger your file will be. In most cases, unless you're engraving a really large image you'll probably not be able to see the difference between a setting of 300 and 600 DPI for this setting.

The next step is to set a value for the Gamma. Click on Adjust and then Gamma.
The Gamma value adjusts the saturation of a photo and for laser engraving a Gamma value of around 2.00 works nicely. Below are two images with Gamma value of 1.00 and 2.00. We want the less saturated image of value 2.00.

![Gamma value 1.00](image1.png) ![Gamma Value of 2.00](image2.png)

The last step is to convert the image into a 1-bit Black and white image. Converting to a 1-bit black and white modifies the dot pattern that is in the image and makes it more suitable for laser engraving. Of course, you don’t have to convert it, but most people like the converted look on most materials more than the non-converted look.

To convert, click on **Bitmaps | Mode | Black and White (1-bit)**.
Corel Photo-Paint provides a convenient way to remove the background in a photo.

Access Photo-Paint by selecting the photo and selecting Edit Bitmap from CorelDraw.
In Photo-Paint, click on Image | Cutout Lab.

In Cutout Lab use the Highlighter Tool and trace around the outside edge of the area you want to keep.
Use the Inside Fill tool and click anywhere in the area that you want to keep.

Click on Preview to see your results.
After clicking on Preview you can use the Add Detail Tool or the Remove Detail Tool to fine tune your photo.

The photo looks much better and is ready to use after using the Add and Remove fill tools.

Click Okay and then go back to CorelDraw to view the finished photo.
The photo is now ready to be converted into a 1-bit black and white for engraving.
Mask Tools

Photo-Paint offers a number of tools that allow you to crop in many different ways. These tools are called the Mask tools and are found in the Mask tool fly out:

The Mask tools require a little more effort to use, but it is worth the time to look into them.

You will gain an understanding of how they work when we use the Ellipse tool in the next section.
Creating a Vignette

A vignette is an image that has been cropped in a way that produces a soft feathered edge to the area being cropped. This is a little more involved method of cropping, but the effects that are created can be very pleasing to the eye.

It’s necessary to carefully follow the order of these next steps. Until you gain an understanding of what the steps do, following in order will make this a very easy task.

First, open a photo in Photo-Paint, or select a photo in CorelDraw and use the Edit Bitmap… button that we used earlier. The next step is to setup Photo-Paint so you can modify the photo.

First, Click on the Mask menu and make sure both Mask Overlay and Marquee Visible are activated (they should have a check next to them).

Next, select the Ellipse Mask Tool from the Tool Bar. Most users use the Ellipse because it provides a nice oval with which to frame the face.

With the Marquee tool selected, your marquee tool options will appear. Click on the Normal Mode tool (next to the word Mode).

Set your Feather Mask Width to 99.

That’s all the set up you have to do. At this point we’re ready to select the area we want your Ellipse Marquee Tool to a starting point on the photo and click and hold down the
mouse. Then, drag a circle (ellipse) across the face in the photo. Move your mouse around until the marquee defines the area you want to keep and then release the mouse.

Photo-Paint does not allow you to easily change the select area. One of the easiest ways to select the area you want is to start from the middle and hold the shift key while you drag your mouse. This will generate a marquee from the center. Practice a couple of times until you get used to it.
When you release your mouse, the mask will show up.

Notice that the oval around the face is fuzzy. This is a result of setting the Feather value from the previous page to 99. If you want a sharper edge, you can lower the feather value and redraw the mask, or, if you like where the mask is, go to the Mask menu, Mask Outline, Feather and the Feather dialog box will appear.

The mask shows up as an orange overlay. It’s important to understand that everything under the orange overly Mask is protected and cannot be modified. This will be important for some applications later on.
Once you have the vignette the way you want it to look, you’re ready to delete the background and save the image.

To delete the background area we need to invert the mask. Remember that everything under the mask is protected? Now we need to protect the face, so we can delete the background.

To invert the mask and protect the face, just click on the Invert Mask button.

Alternatively, from the Mask menu, click on Invert.

Now the mask shows the area that will become our vignette.

To delete the background, click on the Fill tool (the little paint bucket):
Move the fill tool anywhere on the photo and press the Delete key on your keyboard. Your photo will now look like this:

That’s it! You have quickly and easily eliminated the background and you now have a lovely photo with soft feathered edges ready for engraving.

You can now save the photo as a .bmp and then import it back into Corel. It’s ready for laser engraving!
The only setting you may need to change is when you delete the background.

You may need to change your background color so that when you press the Delete key you create a white background. When you press Delete and it creates a background other than white, press Ctrl Z to undo the Delete.

Double click on the two overlapping squares that are the Background color icon. Don’t click on the single square.

You should get the Foreground Color window. Move the slider bar all the way to the top to change your Background color to White. Once you move the slider bar up to the top, the Name will change to White. Click on OK.

After clicking on OK and going back to your photo, select the Fill tool again and press Delete. That should give you a white background and you can now save the photo.
Cropping with the Place Inside Container tool

There is one more method of cropping that is popular. This is done in CorelDraw and is very easy to perform.

For this example we are going to place a photo in an irregular shaped object – a pentagon.

First, place the object over the area of the photo that you want inside the object.

Next, select the photo and click on Effects, PowerClip, Place Inside Container…

You will see a large black arrow.

Use the arrow to click on the outline of the container object.
You have now cropped a photo inside a container. You can use a container of any shape you can create.
Sizing

Now that you’ve cropped your photo and it’s in the form you want to use it we can now size it.

The photo below was downloaded from a digital camera. This sizing process is useful for any photo whether it was acquired from a camera, was scanned or came from the internet. We’ve imported the image below into Corel and we want to engrave this photo onto a plaque. As you can see, it’s about the same size as the plaque, so we need to shrink it. For most objects in Corel you would grab one of the corner handles and shrink or expand until it looked good. With a photo we need to take more care.

- Before sizing the photo, make a duplicate of it first and move it to the side. Because we’re going to manipulate the photo it’s always good to have the original close at hand so we can start over if we want to.

- Decide on the size the photo needs to be. Select the photo and use one of the corner handles to determine the appropriate size. Make a note of the size you want the photo to be after shrinking and then use Ctrl Z to undo it back to its original size.
You should be able to see the size and location of the photo in the upper left corner of Corel. The following screen shot from Corel shows that the size we want the photo to be is 3.125” x 2.528”.

- We’re now ready to size the original photo. Select the original photo and click on **Bitmaps | Resample** in the Corel menu bar.
The Resample window comes up and, as you can see, there are two main parameters that can be changed; Size and Resolution.

Input the size (3.125 x 2.528) that we want the photo to be.

After setting the size, set the resolution. Since we’re going to engrave using 300 DPI, set the resolution here to 300 x 300.

Click OK and you will go back to your Corel Page.

Notice that we now have a photo that fits the plaque with the original photo off to the side.
Softening the Intensity of a photo

It is frequently the case that the photographs you want to engrave get washed out because they are too intense for the laser. This is because most photos are designed to be exceptionally high quality images and there is a lot more information than can be processed in a 300 DPI engraving.

This process can be performed before or after cropping and sizing with the exception of a photo inside a container. For this one process you will need to soften the photo before placing it in the container.

To soften a photo we want to just lighten it so it doesn't look washed out when engraved. You can do this in Corel or Photo-Paint.

You need to make sure the photo is in the correct format before you can adjust the intensity. In Corel, select the photo and go to Bitmaps. If the Image Adjustment Lab is grayed out, you will need to click on Convert to Bitmap…

Set the Resolution to 300 DPI and the color mode to RGB Color (24 bit), and then click OK. This will convert your photo to a mode that can be adjusted.
Select the photo again and go back into the Bitmaps menu.

Click on Image Adjustment Lab.

Usually increasing the Brightness (we increased it to 30) and decreasing the Contrast (we decreased it to -20) is all that is needed. The photos below show the before and after effects.

The Image Adjustment Lab has a number of settings that can be changed. Usually, just changing the Brightness and Contrast are enough to soften the photo.
Inverting a Photo

If you are engraving a photo on dark material like black marble or black anodized aluminum you are going to need to invert the photo before sending it to the engraver. Inverting is nothing more than converting it into a negative; although this can cause complications if you decide you want to invert the photo after all of your other adjustments have been made.

*It's usually best to invert the photo in the early stages of processing, so take the material you are going to engrave on into account before you begin!*

Many users have difficulty with negatives until they try it out a couple of times, so it’s helpful to know how the laser works if you need to think about a negative (inverted) image. The way the laser works is that it fires wherever there is a dot in the artwork. For most engraving materials like wood or acrylic you are creating a dark mark wherever the laser hits the material. On material like black marble you are doing the opposite – you are creating white wherever the laser fires, not dark. Inverting just changes all of the black dots to white and visa-versa.

Inverting a photo is quite easy. In Corel, select your photo and then go to Effects, Transform and Invert.
In Photo-Paint go to the Image menu, Transform, and then Invert.

As you just saw, inverting is easy if you have not created a vignette or other boundary around the photo. If you have created a boundary you will run into the problem where not only is the photo inverted, the background is inverted as well.

To see what this means, let’s look at a photo that was inverted before applying any processes and compare that to one that was inverted after all processes were complete. All of the steps were the same. The only difference was when the image was inverted.
As you can see, there is quite a difference. To prevent this from happening is easy if you know you are going to need an inverted image. I will use the vignette to show the process when processing your photo.

In Photo-Paint use the Mask tool to create your mask area.

This is where we want to invert the image. To invert, go to the Image menu, Transform, and then Invert.

The face has now been inverted.

At this point you will probably want to adjust the intensity of the photo like we did in the previous section. Even though the image is now a negative, the process will be the same.
Notice that there is a lot less black in the photo after modification. The image on the right will engrave onto black marble or anodized aluminum much better than the image on the left.

In the Image Adjustment lab, increase the Brightness and decrease the Contrast.

Whether your image is a negative or positive, what you're looking for in the Image Adjustment Lab is an image that has a lot of gray in it.
At this point, your image is cropped and sized and could be ready to engrave.

The last step is to convert the image into a 1-bit Black and white image. Converting to a 1-bit black and white modifies the dot pattern that is in the image and makes it more suitable for laser engraving. Of course, you don’t have to convert it, but most people like the converted look on most materials more than the non-converted look.

To convert, click on **Bitmaps | Mode | Black and White (1-bit)**.
In addition to using the dithering on photographs, you can also use it with Clipart. Clipart images that have color or fountain fills can be made more interesting by using the Jarvis, Stucki, or Floyd-Steinberg dithering patterns.

The ship sample that we use extensively is a good example.
Engraving murals with tiles

Many users want to create large murals by piecing together a number of small tiles.

This procedure is written using Corel X4, but the process is the same for older versions of Corel. This process will show you how to set up a mural that has a finished size of 48 x 36 inches (4 feet x 3 feet). It uses 12 tiles (4 across x 3 down) that are each 12” x 12” in size.

Create a page in Corel that equals the finished size of the mural – in this example 48 x 36 inches.

Import your artwork then size and place it so that it utilizes as much of the area the 48 x 36 inches as you need. In our example we are going to use almost all of the 48 x 36 inch area.

Note: If you are using a bitmap (jpg, tiff, etc) you run the risk of stretching it so much that it becomes severely distorted. There is no easy way around this. You just need to be aware that many images cannot be enlarged to the sizes required by large murals.
At this point, we have the grid and our artwork set up how we want them. Next, we’ll use the PowerClip tool in Corel to place the artwork inside the grid so that we can then break the grid into 12 different tiles.

Next, use the Graph Paper tool to create a grid that is 4 across and 3 down. This part is a little tricky because the Graph Paper tool is in the Object Tools fly out. In Corel X4 many users go straight to the Table Tool in the Corel tool bar because it looks just like the Graph Paper tool, but the Table Tool will not work for this application.

Use the Graph Paper tool to draw your grid. At this point, don’t worry about its exact size or placement.

Now, use the Object Size boxes to change the size of the grid to match your page size (48 x 36 inches).

After setting the grid size, press the P key on your keyboard. This will place the center of the grid at the center of your page.

At this point, we have the grid and our artwork set up how we want them. Next, we’ll use the PowerClip tool in Corel to place the artwork inside the grid so that we can then break the grid into 12 different tiles.
Select just your artwork (not the grid). Make sure you have everything selected if you have multiple objects.

Go to Effects | PowerClip | and click on Place inside Container…

An arrow will appear. Place the arrow on any grid line and click. You now have a PowerClip Group.

With the image still selected, use the Ungroup tool to ungroup the grid. Select one of the tiles and move it so make sure the grid is ungrouped. This will also show that you have 12 separate tiles ready to engrave.

**Note:** Corel uses a default that automatically centers your image to the center of the grid. This may cause problems for this application.
At this point, there’s one important step you need to take. The grid was created with an outline. Usually you will not want the outlines to engrave. Select all of the tiles and delete the grid lines.

We’re now ready to print.

To turn off Auto-Centering in PowerClip mode go to:
Tools | Options.
Expand Workspace and click on Edit.
Deselect the Auto-center box.
Click Okay.

Select any one of the tiles. We’ve selected the third one across in the top row (we’ve left the grid line on because it’s easier to show the next steps). Use Ctrl + P to go to the Print window.
We’ve selected one of the tiles in Corel. Click on Selection in the Print Range box.

Go to Properties.

Set your Piece Size to match the individual tile size – in this example each tile is 12 x 12 inches.

Set your other laser parameters and click on Okay.
That’s it! Once you press Print, the individual tile will be printed to your laser. All you have to do is place a 12 x 12 inch tile in the upper left corner of your laser system, focus and start the job. When it is finished engraving, select the next tile you want to engrave and follow the same print procedure.

**Condensed Instructions:**

With Print Preview on you can see that the tile we selected in Corel is the tile that will be printed (notice the ears).

In the Print window, go into the Layout tab. Click on the Reposition Images to:

Then select Top left corner from the fly out menu.
1) Measure your tile to determine its size (in our example we are using 12 x 12 inch tiles).
2) Determine how many tiles you need going across and how many going down (4 across by 3 down = a total of 12 tiles).
3) Use the tile size to determine the overall dimensions of the finished mural (in our example – 4 tiles x 12 inches = 48 inches across, 3 tiles x 12 inches = 36 inches down).
4) Create a page that equals the finished size of the mural (48 x 36 inches).
5) Import, create or open your artwork.
6) Size and place artwork on the page.
7) Use the Graph Paper tool (do not use the Table tool in Corel X4) to create a grid (4 across by 3 down).
8) Size the grid.
9) Center the grid.
10) Select just your artwork.
11) In the Corel Menu Bar click on Effects | PowerClip | Place inside container.
12) With the PowerClip arrow, click on any one of the grid lines.
13) Ungroup.
14) Delete grid lines.
15) Select a single tile.
16) Print.
17) In the Print Range box click on Selection.
18) In the Epilog driver properties make your Piece Size match the individual tile size (12 x 12 for our example).
19) Go to the Layout tab.
20) Select Reposition images to…
21) Select Top Left Center.
22) Look at the Preview window. If everything looks good, finish printing.

That’s it! It seems like a long procedure, but it’s really quite easy.
**ADA Signage**

On a regular basis it is impractical to create the raised Braille dots using laser engraving technology. It is easy to create the pictograms and text with the laser, but the actual Braille dots are best left to a different technology. However, if you’re in a pinch and really want to use the laser, we provide some tips below.

The following information is by no means an exhaustive treatment of the ADA requirements and is intended only as a brief overview of some of the common signage requirements. The following links provide information for the Americans with Disabilities Act (ADA).


For many buildings, the types of signs that require Braille are those where permanent identification is provided for rooms and spaces such as restrooms, conference rooms, hotel rooms or any type of permanent space. Generally speaking, signs should be installed on the wall adjacent to the latch side of the door.

The three major components of an ADA Braille sign are:

1) Pictograms – these are easily created using 1/32” adhesive backed plastic cut with a laser or rotary engraving machine.

![Pictograms](image)

2) Text – Letters and numerals shall be raised 1/32 in (0.8 mm) minimum, upper case, sans serif or simple serif type and shall be accompanied with Grade 2 Braille. Raised characters shall be at least 5/8 in (16 mm) high, but no higher than 2 in (50 mm). Pictograms shall be accompanied by the equivalent verbal description placed directly below the pictogram.

3) Raised Braille dots – these can be created using several different methods. Three of the most common methods of producing the dots are shown in the diagram below. The laser and rotary engraver methods incorporate a patented dot technology called Rasters™. The patented Raster dots are dimensionally accurate spheres that are 0.0625” in diameter.

Because this process is patented, you are required to purchase a license to use the technology.

**Where to buy:**

The Raster™ license can be purchased through many different engraving supply companies or directly through the patent holder – Accent Signage Systems - http://www.accentsignage.com. The license grants you the right to use this technology, and to purchase Raster spheres and insertion tools.
The Rasters are inserted into the plastic or other material after a hole has been created using a laser or rotary engraver so that the height of the raster is 0.025" above the material surface.

<table>
<thead>
<tr>
<th>Laser</th>
<th>Rotary Engraver</th>
<th>Photopolymer</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Laser Diagram" /></td>
<td><img src="image2" alt="Rotary Engraver Diagram" /></td>
<td><img src="image3" alt="Photopolymer Diagram" /></td>
</tr>
<tr>
<td>The Raster™ is inserted into a laser cut circular hole and held in place by using a filler (RTV caulking is common) and a backing sheet as insurance.</td>
<td>The engraving plastic is drilled with a 0.060 bit to a depth of 0.042&quot;. The Raster™ is held in place by friction. Rasters™ can be inserted using a hand tool or an automated insertion tool that is attached to your rotary engraver.</td>
<td>The Braille dot is made using the photopolymer process.</td>
</tr>
</tbody>
</table>

ADA Grade 2 Braille is the most common form of Braille. It is a "shorthand" form of Braille, which instead of having one Braille cell correspond with one letter, it uses one or more cells to correspond with groups of letters, whole words, and contractions. California title 24 Braille uses the same "shorthand" character structure as ADA Grade 2 Braille, but the dot spacing grid is a different size. Because of the grid spacing difference, California Grade 24 Braille requires its own font that is not normally included with a standard Braille translating software package. (What a surprise!)

![Grade 2 Braille Cell Diagram](image4)  
**Grade 2 Braille Cell**  
Cell-to-cell spacing = 0.241"  
Dot-to-dot spacing within a cell = 0.09"  
(Vertical or Horizontal)

![California Title 24 Braille Cell Diagram](image5)  
**California Title 24 Braille Cell**  
Cell-to-cell Spacing = 0.20"  
Dot-to-dot spacing within a cell = 0.10"  
(Vertical or Horizontal)

![Braille Dot Diagram](image6)  
<table>
<thead>
<tr>
<th>Braille Dot</th>
<th>0.25&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>Round Dot</td>
<td>1/40&quot;</td>
</tr>
<tr>
<td>(Acceptable)</td>
<td></td>
</tr>
<tr>
<td>Square Dot</td>
<td></td>
</tr>
<tr>
<td>(Unacceptable)</td>
<td></td>
</tr>
<tr>
<td>Flat Top</td>
<td></td>
</tr>
<tr>
<td>(Unacceptable)</td>
<td></td>
</tr>
</tbody>
</table>
PhotoGrav

PhotoGrav is a software package that was designed specifically to manipulate photographs so they would look better when laser engraved. The original developers had a laser and a background in printing and software. They were frustrated with the way photos engraved into wood and so used their background to manipulate their photos in a way that would make them look great when engraved. They then developed different ways of manipulating the photos for different materials besides wood.

PhotoGrav can be very easy to use as it incorporates an automatic conversion method that does everything for you. If you want to make adjustments to your photos you can use their interactive process to create your own look.

Converting clipart using PhotoGrav

We showed examples in the Print Driver section of a piece of clipart that was engraved using PhotoGrav. What we didn’t show was how to make a piece of clipart compatible so it can be converted using PhotoGrav. PhotoGrav only converts the following image types: .jpg, .bmp, .tiff, and .png. Corel clipart, as well as other types of clipart do not start life as one of these formats so you must first convert your clipart image to one of these file formats. Follow these instructions to create one of these image types:

Import a piece of clipart into Corel

With the clipart selected go to Bitmaps and Convert to Bitmaps

Select Grayscale (8-bit) and then OK to convert your image to a grayscale.
With your image selected, click on Edit Bitmap.

Clicking on Edit Bitmap will take your image into Corel PhotoPaint.

Once your image is in PhotoPaint, save it as one of the PhotoGrav supported images.
We’ll save this as a .bmp.

Now, open up PhotoGrav and open the file you just saved.
At this point you select your material and click on Final Process and you’re finished.

PhotoGrav shows you what your engraved image should look like. At this point, you can go back and use the Interactive Process to fine tune your image.

Save the Engraved Image and it is then ready to import into Corel.

After engraving you can see that the engraved image looks very close to the simulated image in PhotoGrav.
Print Merge

Corel has the ability to merge a list of names with a master piece of artwork that is then used to populate a large number of individual plates, or tags, etc. The Print Merge function is actually very powerful and has many different capabilities but we’re only going to cover a small subset of those capabilities and show one of the most useful methods of creating multiple pieces with variable data.

This exercise is going to show how to engrave and cut 20 badges (3.5" x 2" in size) from three pieces of wood (each sheet of wood is 15" x 5" in size). Each badge has three variable data fields and one fixed field.

First, let’s set up the tag in Corel:

The variable fields are: Title, Name and Year. The fixed field is Hexalon Corp.

Next, we need a data file. For this exercise we’re going to create an Excel file:
Close your Excel file and go back to Corel. Go to File – Print Merge and then Create/Load Merge Fields.

We aren’t going to use the Create new text option, we’re going to open a database file (ODBC data source).

Press **Next** after highlighting Import Text . . .

Select ODBC Data Source, and then click on Select ODBC Data Source.
Select the Machine Data Source tab.

Select Excel Files and then OK.

Navigate to your Excel file that you saved, select it and click on OK.

Your table will come up. All you need to do is click on OK.
The next few windows will let you review or edit your data. If it’s okay, click through the windows and then Finish.
After clicking Finish, you’ll go back to Corel. The Print Merge Tool Bar will be activated.

At this point we’re going to setup the artwork to accept the variables that are in the Excel file. The three variables are Name, Title and Year. To set up each variable you need to swipe across it so it is highlighted as in the diagram to the left. This is very important because just selecting the name will not do anything.

We have the Name variable highlighted. Go to the Field drop-down menu and select Name, then click Insert. We’re going to do this two more times, once for the Title field and once for the Year field.

Highlight the field, go to the drop-down menu and select the correct field and then click Insert.

After inserting the data fields they will be displayed like this and your Print Merge Tool Bar will be ready for the next step.
Go to File – Print. At this point we’re ready to print, even though it doesn’t look like it.

The laser had been set up to print to a 15 x 5 inch piece of wood, so the file shows up in the middle of the preview panel ready to print. What we need to do next is set up the print file so that we gang up as many of the 3.5 x 2 inch tags as will fit on the 15 x 5 inch pieces of wood.
Click on the Layout tab and then click on Edit.

We're now in the preview screen for Imposition Layout. Notice that we have a tag in the middle of a 15 x 5 inch page.

We want to see the artwork so we'll click on the Template/Document Preview tool.

We can now see our artwork.
Now we want to populate the entire piece of wood. To do this, increase the Pages Across/Down with the appropriate number of pieces that will fit on the wood. In this case we know that we can fit 4 across and 2 down.

We now have the 15 x 5 inch sheet filled with as many 3.5 x 2 inch tags as will fit.

We also show that there are three pages. If we look at the other pages we’ll see that they contain the remainder of the 20 tags we started with.

Now, just click on the Done Editing Layout check box and you’ll go back to the Print Window.

If your laser settings are properly set, click on Print and you will print three pages of badges to the laser.
CAVEATS!

The Print Merge function is a very useful tool and should be understood by anyone operating a laser on more than a casual basis.

There are things that can go wrong if you’re not familiar or paying close attention:

1) There’s a little button in the preview page that can help a lot when you’re populating your sheet with badges, tags etc.

When you’re populating your page you want to make sure the Maintain Document Page Size button is set properly for what you want to do. When it’s highlighted (as above) it maintains the piece size of your tags. In our exercise, it maintains the tag size at 3.5 x 2 inches.

In the screen shot below you can see that since the tags keep their size they are spread out over the edges of the page. If you look at the screen shot above you can see that we set up 4 tags across and 4 tags down. The 15 x 5 inch sheet of wood isn’t big enough to handle more than a total of 8 so the remainder are represented as overflow.
2) Another issue you should be aware of is that when you print, all three pages will print to the laser at the same time. You will receive the same file name at the laser, with one being labeled Job 1, the next being labeled Job 2 and the third, Job 3. If you set up your printing to do this you will place a sheet of wood in the laser, run Job 1, and when that’s finished, place another piece in the laser and ruin job 2, etc. Printing multiple pages is discussed in detail in your manual. It’s intuitive once you’ve done it, but if it’s your first time you may not realize what’s happening.

If the Maintain Document Page Size button is **not** highlighted and you keep adding tags to the page, the tags will all be shrunk to fit. This is useful for some applications, but not very useful for engravers.
Model Making
Laser Engraving and Cutting Resources

Epilog Laser's website is the number one source for engraving and cutting resources on the web. Take a look at our Sample Club with over 75 different files and growing every month! Or our Technical Library filled with helpful articles on maintenance, artwork setup and much more. We want to be your provider of everything you need from industry material links to cool new ideas. Start exploring to find out more!

Sample Club: The Sample Club is our resource for finding new project ideas. Each month we add at least one new file to the site for our CO2 or Fiber laser systems.

Technical Library: Our popular page for finding articles and how-tos on system maintenance, file setup and video instructions.

Industry Links: Find links to suppliers for all types of laserable materials and supplies.

Newsletters: Epilog offers two different newsletters - our monthly e-newsletter and a quarterly printed newsletter that our clients receive.

Educational Clinics: We list different clinics held across the United States by our distributors and suppliers.

Check out our web site for tons of information about laser projects, tips, tricks, technical support, etc.
Additional Training Resources:
www.acdrp.org Assoc CDR Professionals.

The Association for Corel Draw Professionals offers online video training courses. Access to this video training can be purchased through Epilog or your Epilog distributor. The ACDRP Premium Membership cost is normally $240/year, but can be purchased as part of this seminar for only $180 ($60 Savings!).

www.laserbits.com

LaserBits offers an online resource and training site that is available on a subscription basis. Based on the successful Laser Clinics, the price of a subscription is affordable and LaserU is available 24/7. LaserU covers a wide range of topics including CorelDRAW, Corel PHOTO-PAINT as well as engraving techniques for new and experienced users alike. Subscription costs range from $119 to $395.